
 

 
      
 

 

 

ANÁLISE DE VIBRAÇÕES MECÂNICAS POR IMPACTO FRONTAL 

EM UM CHASSI SPACE FRAME DE MINI BAJA VIA ELEMENTOS 

FINITOS 
 

 

Resumo: Os veículos “off road” de Mini Baja utilizam chassi do tipo space frame na sua 

parte estrutural. Tal tipo é composto de elementos treliçados tridimensionalmente, e estes 

componentes estruturais garantem maior resistência mecânica, leveza e segurança. Contudo, 

é muito comum nas competições ocorrerem situações extremas com o veículo, e estas acabam 

gerando impactos no chassi. O impacto pode deformar elasticamente ou plasticamente por 

conta do carregamento ocasionado, mas também transmite vibrações mecânicas para a 

estrutura, e estas podem fazer com que a mesma entre em ressonância. Através do software 

FEMAP™, é feita uma análise computacional das simulações de impacto frontal via 

elementos finitos, verificando assim o comportamento estrutural do chassi e as consequências 

das vibrações transmitidas para ele.  
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1 INTRODUÇÃO 

 A Competição Nacional Baja SAE Brasil, organizada pela SAE (Society of Automotive 

Engineers), é um evento universitário que ocorre anualmente em São José dos Campos - SP. 

Trata-se do projeto de protótipos Mini Baja (veículos “off-road”) e competição entre eles, 

representando diversas Instituições de Ensino Superior de todo o Brasil participantes, com o 

intuito de expandir os conhecimentos teóricos e práticos e habilidades em desenvolvimento de 

projetos, com alunos de diversas engenharias. 

 Os veículos projetados devem seguir os regulamentos e normas propostos pela SAE. 

Estes regulamentos visam garantir a segurança do piloto e integridade dos veículos durante as 

competições. Durante a avaliação dinâmica de “Endurance”, os veículos passam por 

obstáculos acentuados em um circuito com terreno acidentado durante a prova com duração 

de 4 horas. Em situações extremas como passar por crateras profundas ou por troncos 

robustos, o sistema de suspensão pode não suportar suficientemente o estresse imposto sobre 

o carro, e este tipo de situação pode ocasionar em um capotamento ou impacto em algum dos 

extremos do carro com a pista. Quando isto ocorre, a estrutura pode sofrer tanta deformação 

elástica como plástica dependendo da carga recebida pelo impacto e das propriedades da 
mesma. 

 Se a estrutura receber um impacto ou choque forte o suficiente para que o carregamento 

supere a resistência do material do chassi, esta irá se deformar permanentemente, com 

probabilidade grande de ruptura. Pela parte mecânica, as vibrações transmitidas durante o 

choque podem gerar frequências tão grandes que podem levar a estrutura a entrar em 

ressonância, ou seja, ser destruída. 

 Este artigo tem por finalidade analisar as vibrações que ocorrem em um chassi do tipo 

space frame para Mini Baja em uma das situações de impacto mais comuns da área 

automobilística – impacto frontal –, simulando via elementos finitos pelo software pré-

processador FEMAP™ com seu pós-processador NX Natran™ o comportamento do chassi 

pela parte modal analisando a frequência de excitação com relação a frequência natural e 

exibindo seus resultados. 



 

 
      
 

 

 

2 FUNDAMENTAÇÃO TEÓRICA 

2.1 Conceito de chassi e elemento estrutural 

 A construção de elementos estruturais para sustentação de veículos tem sido um grande 

desafio para o automobilismo, que tem buscado alcançar um padrão ideal entre leveza e 

resistência mecânica. Estes elementos são cada uma das partes diferenciadas do corpo, que, 

ainda que vinculadas, podem ser divididas em uma estrutura singulares para efeitos de seu 

projeto. O projeto e cálculo destes elementos é feito de acordo com os princípios da 

engenharia estrutural e da resistência dos materiais. 

 O chassi ou quadro é uma estrutura de suporte utilizada em um veículo automotor que 

tem por finalidade proteger todos os seus subsistemas e garantir a segurança de quem estiver 

dentro dele. Pode ser essencialmente comparado a um esqueleto, visto que sustenta todos os 

sistemas e é a base em que o veículo praticamente corre. 

 

2.2 Space frame 

 Dentre as ramificações da área de chassi existem vários tipos que são utilizados pelas 

empresas automobilísticas, diferenciando-se apenas por sua finalidade. Os principais tipos de 

chassi são o chassi de túnel, chassi de longarinas, monocoque e space frame. 

 Existem diversas características comuns entre estes tipos de chassi, como resistência a 

carregamentos específicos na estrutura ou proteção de partes vulneráveis do veículo, enquanto 

outros tendem a fazer com que todos os componentes do veículo se comportem como uma 

única estrutura, de forma a acoplar os subsistemas de modo satisfatório para com o projeto. 

 O “space frame”, ou estrutural espacial, é uma estrutura com elementos treliçados, ou 

seja, com geometrias triangulares. Por conta da sua configuração, este arranjo é forte devido a 

sua alta rigidez e distribuição dos carregamentos para os extremos de cada elemento. Cargas 

de flexão são transmitidas como tração e compressão de cargas ao longo dos nós. 

 A aplicação do space frame não se restringe somente ao automobilismo, mas também a 

estruturas rígidas como pontes, estádios, aeroportos, edifícios e outros. O space frame é 

geralmente projetado com uma matriz de rigidez, e pode ser definido tanto por elementos 

simples como tubos quanto por elementos rígidos como treliças. 

 O custo de fabricação deste modelo geralmente é mais barato que os demais por conta de 

ser fabricado com componentes mais simples. Porém, a complexidade da fabricação de um 

space frame pode variar desde a estrutura treliçada mais simples até a mais complexa. 

 Este tipo de estrutura é praticamente uma junção das principais características do chassi 

de longarinas e o monocoque, destacando-se por apresentar uma massa menor que os demais. 

Como a massa reduzida é um dos principais objetivos na construção de um chassi, é trivial 

que quanto menor esta for, menor será a força necessária para acelerar o corpo. Tal afirmação 

é confirmada pela 2ª Lei de Newton, em que o somatório das forças resultantes em uma 

direção é a força resultante “F” (em Newton) e é igual ao produto da massa “m” (em kg) pela 

aceleração “a” (em m/s²), ou seja: 
 

 
 

2.3 Vibrações mecânicas em estruturas treliçadas 

 Em todas as áreas das Engenharias, existem diversos tipos de elementos de sustentação 

físicos que abrangem diversos sistemas. A treliça é uma das estruturas de fundamental 



 

 
      
 

 

 

importância e possui algumas propriedades notáveis, como vibrações cíclicas com poucas 

frequências naturais dominantes, ressonância e modos naturais de vibração. 

 Os impactos em si podem ser caracterizados por três tipos: o impacto frontal, o impacto 

lateral e o capotamento. 

A rigidez de um chassi é o que diferencia um carro no momento da colisão. Para 

determinar a rigidez em uma estrutura treliçada tridimensional, pode-se fazer uma analogia 

para uma treliça bidimensional isostática. 

 Adotando-se como exemplo uma treliça com um carregamento vertical “P” aplicado em 

um nó, deve-se primeiramente encontrar o deslocamento de um nó para uma treliça 

bidimensional: 
 

 
 

 Em que “ ” é o deslocamento provocado por esforços de flexão, “ ” é o 

deslocamento provocado por esforços cisalhantes e “ ” é o deslocamento provocado por 

esforços normais. 

 Como na treliça do exemplo os esforços de flexão e de cisalhamento são nulos, visto que 

a carga é aplicada em um nó, tem-se que: 
 

 
 

 Logo, a equação do deslocamento resulta em: 
 

 
 

 Em que “N” é esforço normal da estrutura real (N); “ ” é o esforço normal da estrutura 

virtual (adimensional); “E” é o módulo de elasticidade do material (Pa); “L” é o comprimento 

de cada elemento da estrutura (m) e “A” é a área da seção transversal (m²). 

 Deste modo, como os elementos estruturais possuem dimensões permanentes, pode-se 

simplificar a Equação (4) deste modo: 
 

 
 

 Ao calcular os esforços normais das barras da treliça, utiliza-se o Método do Trabalho 

Virtual para encontrar os esforços normais da estrutura virtual (HIBBELER, 2005). 

 Como a estrutura está recebendo um carregamento “P”, a equação do deslocamento 

(Equação 5) ficará em função do mesmo. Contudo, como o conceito de rigidez é a capacidade 

que a estrutura tem de se deslocar unitariamente em uma determinada direção, o 

deslocamento deverá ser unitário e a carga P assumirá a própria rigidez, ou seja, em que δ=1 e 

P=K. Substituindo estas relações na Equação (5), tem-se a rigidez para a treliça: 
 

 
 

 Em que “K” é a rigidez (N/m); “E” é o módulo de elasticidade do material (Pa); “A” é a 

área da seção transversal (m²); “N” é esforço normal da estrutura real (N); “ ” é o esforço 

normal da estrutura virtual (adimensional) e “L” é o comprimento de cada elemento da 

estrutura (m). 

 Nas situações de impacto, a carga aplicada na estrutura não é localizada nos nós, mas sim 

em cima de sua superfície. Este tipo de carga, diferentemente da carga em um ponto, gera a 



 

 
      
 

 

 

contribuição do esforço normal para o cálculo do deslocamento da estrutura, visto que 

existem momentos fletores atuando nas barras. A contribuição de cisalhamento não atua neste 

caso devido às cargas estarem atuando de forma a flexionar a estrutura, de frente para o 

chassi.  Logo, o deslocamento resultante será: 
 

 
 

 Substituindo os deslocamentos relativos, tem-se: 
 

 
 

 Em que “M” é o momento fletor da estrutural real (N.m); “ ” é o momento fletor da 

estrutura virtual (adimensional) e “I” é o momento de inércia (m⁴). 

 Logo, utilizando as relações (6) e (7) para a Equação (10), tem-se: 
 

 
 

 A rigidez não sofre influência da magnitude do carregamento imposto sobre a estrutura, 

mas sim pelo seu posicionamento nos nós. A posição da carga decorre na mudança das 

reações nos apoios, e tais reações afetam diretamente na rigidez. 

 Com a rigidez calculada, obtém-se a frequência natural da estrutura. Assim como no 

sistema massa-mola, analogamente a frequência natural das treliças é obtida da mesma forma: 
 

 
 

 Em que “ω” é a frequência natural da estrutura (Hz); “K” é a rigidez (N/m) e “m” é a 

massa (kg). 

 É possível evitar a ressonância de um sistema aumentando sua rigidez ou mudando sua 

massa. Em ambos os casos se altera a frequência natural da estrutura. No caso do impacto, 

quanto maior for a colisão, maior será a frequência de excitação gerada sobre o chassi. 

 Para garantir a segurança dos componentes, a frequência de excitação deve ser menor que 

a frequência natural da estrutura, evitando de forma definitiva a ressonância do sistema. 

Dependendo da posição do impacto, a estrutura pode ter um modo diferente de vibrar. 

 Um dos elementos fundamentais na análise modal é o modo de vibração. Geralmente os 

softwares comerciais mostram o modo de vibrar em forma de deslocamento unitário. Isso 

acontece porque esta análise é considerada somente para conclusões qualitativas, ou seja, os 

valores dados de deslocamento do programa são ilustrativos para que seja possível visualizar 

a forma com que a geometria se deforma. A grandeza do deslocamento só pode ser analisada 

se as condições de contorno estivessem presentes na simulação. Ainda assim, esta informação 

é útil caso se deseje saber em qual região haverá o maior deslocamento, caso o sistema seja 

excitado na sua frequência natural. 

 É notável que em uma simulação modal não é possível se tirar conclusões a respeito das 

tensões atuantes no sistema, já que os deslocamentos dos nós são somente representativos, 

sem nenhuma semelhança em intensidade com o deslocamento real da estrutura. 

 Também não é possível afirmar que uma estrutura irá entrar em colapso caso a frequência 

de excitação coincida com a frequência natural. A única conclusão imediata possível, caso 

isto ocorra, é que haverá a amplificação dos deslocamentos da estrutura, e esta amplificação 



 

 
      
 

 

 

pode causar alguns tipos de falhas como: por ruptura (a qual é foco deste trabalho), por fadiga 

ou por ruído (EAC, 2013). 

 A falha por ruptura ocasiona na deformação amplificada que excede a deformação crítica 

do material, causando o escoamento ou ruptura do mesmo. Já a falha por fadiga ocasiona na 

deformação amplificada que aumenta a tensão na estrutura a ponto de a sua não ser mais 

considerada infinita ou com a vida inferior ao número de ciclos determinados no projeto, 

enquanto a falha por ruído é gerada pela amplificação do deslocamento da estrutura. 

 Estes parâmetros físicos e vibracionais são os principais fatores analisados no momento 

de se projetar qualquer tipo de estrutura, independentemente de ser móvel ou fixa. 

 

2.4 Método dos Elementos Finitos 

 Os problemas estruturais sempre foram estudados fundamentalmente na Engenharia. Tais 

problemas são baseados no dimensionamento, definição de material e no projeto de uma 

estrutura física. 

 Fatores como o material, capacidade de suportar esforços axiais, radiais, cisalhantes, 

fletores e normais fazem total diferença no projeto de uma estrutura. Para se definir as 

propriedades e o comportamento destes fatores, são utilizados métodos matemáticos que 

mostram ao engenheiro o que acontecerá com a estrutura. Contudo, costuma-se utilizar um 

sistema equivalente ao da estrutura real, a fim de simplificar os cálculos. Porém, por conta da 

aproximação analítica perde-se a precisão do comportamento real. 

 O Método dos Elementos Finitos (ou MEF) atua de forma que, malhando uma estrutura 

em finitos elementos, que podem ser definidos de acordo com a qualidade de precisão da 

análise, torne cada um de seus elementos em um sistema resultante da estrutura ao todo 

naquele espaço delimitado. Realizando os cálculos para somente um elemento, tem-se o 

comportamento dele na estrutura, que poderá ser diferente ou não de outros pontos da mesma. 

Este mesmo processo, realizado para toda a estrutura, gera uma análise resultante que 

aproxima ao máximo a estrutura modelada ao sistema físico. 

 Com isto, adota-se o software FEMAP™, da Siemens, que é um dos melhores na 

plataforma de elementos finitos. Seu sistema atua em duas partes: seu pré-processador, 

denominado como o próprio FEMAP™, que é o pré-processador do conjunto que atua na 

parte de modelagem e definição de parâmetros do sistema; e o seu pós-processador NX 

Nastran™, que atua com a simulação e processamento de dados da análise, demonstrando o 

comportamento do sistema. 

 

3 METODOLOGIA 

 Como o estudo do chassi é centrado na verificação da sua ressonância, devem-se estudar 

a sua frequência de excitação e a sua frequência natural. Logo, a análise consiste em duas 

etapas: obter individualmente a frequência de excitação e a frequência natural. 

 Utilizando o software Autodesk Inventor Professional®, realizou-se a modelagem e 

dimensionamento do chassi, seguindo a regulamentação das normas da SAE Brasil, de acordo 

com a Figura 1a. 

 Os tubos utilizados no chassi são de dois tipos: os primários que são tubos de aço-

carbono AISI 1020 com 31,75 mm de diâmetro e 2 mm de espessura e os secundários que são 

tubos de aço AISI 1020 com 28,7 mm de diâmetro e 2 mm de espessura. As propriedades 

mecânicas destes tubos necessárias para a análise foram coletadas da bibliografia e reunidas 

na Tabela 1. 

 

 



 

 
      
 

 

 

Tabela 1 – Propriedades do material (Aço AISI 1020). 

 
Fonte: MatWeb. 

 

 Os tubos primários são os que compõem a maior parte estrutural do chassi, que é mais 

propensa a sofrer deformações, enquanto os secundários (ou auxiliares) servem como reforços 

para distribuir as tensões para os nós e garantir maior segurança. 

 Para realizar a análise computacional via elementos finitos, utilizou-se as linhas de centro 

do chassi como base, ou seja, sua projeção axial, conforme Figura 1b. 
 

Figura 1 – Projeto do chassi em CAD. 

a)  b)  
Fonte: Autor. 

 

 Com o esboço na plataforma da Autodesk®, exporta-se o arquivo no formato *.step para 

que o desenho CAD seja importado e reconhecido no FEMAP™. Feita a importação no outro 

software, a parte de modelagem permanece concluída e o esboço está pronto para ser 

analisado em elementos finitos. 

 No FEMAP™, as funções do sistema estão divididas por abas, ou seja, tudo o que estiver 

relacionado à geometria do desenho está contido na aba Geometry, enquanto tudo o que 

estiver relacionado à malha da estrutura (tamanho dos elementos, seleção de elementos, etc.) 

está contido na aba Mesh, e assim por diante. 

 Para diferenciar os tubos primários dos secundários e garantir a discretização dos 

elementos, utilizou-se no FEMAP™ o comando Modify → Color para alterar as cores de 

elementos individualmente. Desta forma, utilizou-se o branco para representar os primários e 

o vermelho para representar os tubos secundários, conforme Figura 2a. 

 Logo, deve-se adicionar as propriedades do material à análise pela aba Model → 

Material, já relacionadas anteriormente na Tabela 1. Em seguida, cria-se uma propriedade 

pela aba Model → Property, em que se inserem as dimensões físicas dos tubos como diâmetro 

e espessura.  Utiliza-se a geometria de Beam (elemento de viga) para o chassi, visto que, 

experimentalmente, tal tipo apresentou melhor desempenho de análise computacional que 

outros por abranger toda a superfície dos tubos, de forma a manter a sua modelagem 

curvilínea. Para cada tipo de tubo do chassi, deve-se criar a sua propriedade separadamente. 

 O veículo de BAJA atinge no máximo velocidades em torno de 60 km/h quando está em 

um percurso reto e sem interferências, dependendo das condições do projeto e de seus 



 

 
      
 

 

 

componentes, limitados pelo motor estabelecido pelo regulamento. Contudo, durante as 

provas de enduro, ocorre de existirem diversos obstáculos como troncos, pedras e buracos que 

impedem o carro de atingir seu desempenho máximo, além dos percursos serem curvos e 

distorcidos. Desta forma, verificou-se que as velocidades dominantes na maioria do tempo da 

prova de enduro são de 20 e 30 km/h (JONES, 1997). 

 A situação de impacto frontal é dinâmica por conta de o veículo estar em movimento, 

porém pode-se realizar uma equivalência para um sistema quase estático, em que se analisa o 

momento em que o veículo colide com o obstáculo, que neste caso, seria o próprio solo ou 

uma parede. 

 Os pontos que sofrem maiores sobrecargas durante o impacto são os pontos de fixação da 

suspensão e do amortecedor, visto que, analogamente, atuam como apoios para a massa 

suspensa do veículo, isto é, toda a carga que o sistema de suspensão consegue carregar. 

 Dito isto, deve-se definir na análise as condições de contorno da estrutura, isto é, onde 

serão os seus pontos de fixação. Utiliza-se os pontos de fixação da suspensão como parâmetro 

de análise, através do comando na aba Model → Constraint → On Point. Utiliza-se apoios de 

terceiro gênero, conforme Figura 2b. 
 

Figura 2 – Modelo computacional do chassi no FEMAP™. 

a)  b)  
Fonte: Autor. 

 

 Com as velocidades relativas das colisões já obtidas, utiliza-se a equação de Impulso para 

se obter a força de impacto causada pelo choque do veículo: 
 

 
 

 Em que “I” é o impulso (kg.m/s); “m” é a massa do corpo (kg); “v_f” e “v_i” são 

respectivamente a velocidade final e inicial do corpo (m/s); “F” é a força de impacto (N) e “t” 

é o intervalo de tempo (s). 

 Integrando “F” e simplificando a Equação (11), tem-se: 
 

 
 

 Para fins experimentais, utiliza-se a variação de tempo de 0,1s baseada baseado em testes 

de colisão entre veículos durante o intervalo de tempo do próprio choque (ESSS, 2009). Logo, 

adotando a massa de 250 kg, referente à estimativa da massa total do veículo montado com 

um piloto de 60 kg, obtém-se as forças de impacto F1=13,89 kN (para a velocidade de 20 

km/h) e F2=20,83 kN (para a velocidade de 30 km/h). 

 Deste modo, são realizadas duas análises, cada uma com sua respectiva força de impacto 

adequada individualmente. Com as forças obtidas, pode-se aplicar as cargas na parte frontal 

do chassi, pelo FEMAP™, na aba Model → Load. Deve-se criar uma propriedade referente à 



 

 
      
 

 

 

força aplicada, escolher o eixo de referência com magnitude no SI, isto é, em Newton. A 

carga de impacto é distribuída por toda a superfície dos tubos frontais, conforme Figura 3. 
 

Figura 3 – Carregamento na estrutura representado vetorialmente. 

 
Fonte: Autor. 

 

 Com as condições de contorno e as cargas aplicadas no chassi, deve-se aplicar a malha na 

estrutura. Para garantir maior precisão de análise, deve-se definir tamanho dos elementos pela 

aba Mesh → Mesh Control → Default Size. Na aba Mesh → Geometry → Curve, aplica-se a 

malha na estrutura.  

 Utiliza-se o comando Coincident nodes para criar a ligação entre os nós presentes na 

extremidade de cada elemento e assegurar a ligação rígida entre eles, visto que ao serem 

importados do Inventor® eles não apresentavam tal união, estando atuando como elementos 

soltos no conjunto, ou seja, separados. 

 Através de testes para definir um padrão entre precisão e tempo de análise, foi adotado o 

elemento de tamanho 2,7 mm, e com isto foram gerados 1273 nós e 3460 elementos no total. 

Por fim, a estrutura já está com suas devidas propriedades, cargas, restrições e malhas 

definidas. Logo, deve-se solicitar o tipo de processamento desejado do FEMAP™ através da 

aba Model → Analysis → New, criando um novo processo. 

 Como é proposto o estudo de vibrações e da frequência de excitação do chassi, adota-se 

no comando de análise na caixa Analysis Type → Frequency/Harmonic Response para se 

obter as frequências geradas pelos carregamentos. Em seguida, realiza-se a análise.  

 Para se obter a frequência natural do chassi não é necessário adicionar carregamento e 

condições de contorno à estrutura. Logo, deve-se somente adicionar as propriedades dos 

materiais na estrutura, gerar as malhas e realizar a análise de Frequency/Harmonic Response, 

da mesma forma que a análise para a frequência de excitação. 

 

4 ANÁLISE E INTERPRETAÇÃO DE RESULTADOS 

 Comparando os resultados obtidos, obtiveram-se 10 frequências naturais do chassi para 

seus respectivos modos de vibração. Para a análise com o carregamento F1, referente a 

velocidade de 20 km/h, bem como para a análise com o carregamento F2, referente a 

velocidade de 30 km/h, obtiveram-se suas respectivas frequências de excitação. Tais 

informações encontram-se na Tabela 2. 
 

Tabela 2 – Frequências emitidas pela estrutura livre, para F1 e para F2, respectivamente. 

 
Fonte: Autor. 



 

 
      
 

 

 

5 CONCLUSÃO 

 Verifica-se, realizando um comparativo entre as frequências de excitação geradas pela 

carga de impacto e as frequências naturais da estrutura, que a estrutura não entra em 

ressonância. Isto se deve ao fato de que as suas frequências naturais são muito baixas quando 

comparadas as de excitação, pelo menos do 1º ao 6º modo. 

 Quando a frequência natural atinge a faixa de 54,32 Hz no seu 7º modo, as diferenças 

entre as frequências tornam-se menores, podem ainda continuam contidas em um intervalo de 

segurança médio de mais de 62,9% de diferença entre as mesmas, aproximadamente. Em um 

caso particular, as frequências do 10º modo natural e o 2º modo de excitação da velocidade de 

30 km/h possuem uma diferença mais baixa, atingindo cerca de 1,88%. 

 Mesmo que a estrutura sofra deformações por conta do impacto, as mesmas não causam 

danos críticos a estrutura. Isto comprova que, em situações de impacto frontal com 

velocidades de 20 e 30 km/h, o dimensionamento do chassi estudado é válido para manter 

condições de segurança adequadas tanto para o piloto quanto para os subsistemas do veículo. 

 Para projetos de chassi que possuam problemas vibracionais, sugere-se revisar o 

dimensionamento do chassi, a fim de otimiza-lo fisicamente, e realizar posteriores análises 

modais para verificar se as condições de segurança estarão adequadas. É possível evitar a 

ressonância do sistema enrijecendo a estrutura ou mudando a sua massa. Em ambos os casos 

se altera a frequência natural da estrutura. 

 Pela parte vibracional, o chassi apresenta condições aceitáveis para ser adotado em um 

projeto. Contudo, futuramente é necessária realizar a análise de deformação do material com a 

finalidade de verificar se as possíveis deformações ocasionadas pelo impacto influenciarão o 

chassi de forma crítica. 
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ANALYSIS OF MECHANICAL VIBRATIONS BY FRONTAL IMPACT 

ON A SPACE FRAME CHASSIS OF MINI BAJA USING FINITE 

ELEMENTS 

 

 

Abstract: The off-road vehicles of Mini Baja use a space frame chassis in its structural part. 

Such type is composed of tridimensional truss elements, and these structural components 

ensure greater mechanical resistance, lightness and safety. However, it is very common in 

competitions that extreme situations occur with the vehicle, and these end up causing impacts 

on the chassis. The impact may deform elastically or plastically because of the loading 

caused, but it also transmits mechanical vibrations to the structure, which can cause the 

structure to resonate. Through the FEMAP™ software, a computational analysis of the 

frontal impact simulations via finite elements is carried out, verifying the structural behavior 

of the chassis and the consequences of the vibrations transmitted to it. 

 

Key-words: vibrations; chassis; space frame; Baja; impact. 


